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Introduction

This document is designed to outline the necessary requirements to properly implement
MicroStation V8 with Eagle Point software. The information is presented in a manner that
presumes the decision to migrate to MicroStation V8 has been made and presents guidance
on the best approach for a successful implementation.

This document outlines some of the features that are new or different in MicroStation V8. This
summary of product changes is meant to give you an overview of how using MicroStation itself
has changed and how this may affect your workflow.

Eagle Point, as of this writing, has chosen to support several of these features, although some
features have not been fully adopted. This document outlines features related to Eagle Point
and your ability to take advantage of them when working within Eagle Point projects.

This document is organized into sections that provide more detailed information to assist you
in implementing Eagle Point with MicroStation V8. This includes considerations to make
before upgrading to Eagle Point 4.1.0, converting projects and support files, and any known
limitations that you should be aware of as you begin the implementation process.

Throughout this document references are made to MicroStation V7 or V7 design files. This
convention is used to describe earlier versions of MicroStation, including 95, SE and J.

What's New/Different in MicroStation V8 and Eagle Point
2004 Q1 4.1.0

The following sections outline new features and changes in MicroStation V8 and what impact
they have when Eagle Point is running in conjunction with MicroStation V8. We have chosen
to highlight some of the more significant changes as they pertain to Eagle Point. The Text in
REGULAR font is a summary of the feature in MicroStation V8. The text in BOLD denotes the
Eagle Point relationship with that feature.

Workmodes

MicroStation V8 allows AutoCAD DWG files to be opened and saved to its native format.
MicroStation V8 also supports the ability to work with MicroStation V7 design files and save
them back in their original format. This is accomplished by working in what is called a
workmode. The workmode prevents creating any entities or objects that cannot be natively
represented in the original file format (e.g. multiple design models, design history, etc.) while
allowing the rest of MicroStation V8's functionality.

For example, working in V7 workmode prevents you from creating levels, models and
references to V8 and DWG files. In DWG workmode, you may create multiple sheet models
but are limited to one design model (the default).

When using Eagle Point in MicroStation V8, Eagle Point is operating in the native V8
design file format (or V8 workmode). Eagle Point does not support using MicroStation
V8 in workmodes other than the V8 design file format. Therefore, Eagle Point
commands cannot be used with MicroStation V8 when operating in V7 or DWG
workmodes. Only V8 DGN files that are part of the Eagle Point project can be acted on
by an Eagle Point command.

When using the MicroStation File>Open command to open a V8 DGN, Eagle Point
allows the DGN to be viewed, but any Eagle Point command that interacts with CAD will
launch the last loaded project DGN.
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When using the MicroStation File > Open command to open a DWG file, Eagle Point
will continue to be loaded, however any command that interacts with CAD will launch
the last loaded project DGN. This allows viewing of the DWG file while keeping the
Eagle Point environment open.

When opening a V7 DGN through the MicroStation File>Open command while in the V8
workmode and running Eagle Point, a MicroStation prompt appears asking to convert
the design file to V8 or to open the V7 DGN in a read-only environment. If you convert
the DGN, you will stay in the V8 workmode. If you don’t, the system switches to the
read-only V7 workmode. In either situation, any Eagle Point command that interacts
with CAD will launch the last loaded project DGN.

In order to use V7 DGN files with Eagle Point in MicroStation V8, they must first be
converted along with the rest of the project. Please refer to Converting Eagle Point
Projects on page 11 for additional information.

Models

A single design model within a MicroStation V8 design file can be thought of as being similar
to what a design file was in MicroStation SE/J. It has its own views, level states, working units
and reference file attachments. A single design file has the capacity to store an unlimited
number of these models.

There are two types of models: Sheet and Design. A Design model can be either 2D or 3D
and is a container for design elements. Design models are used as an active model, as
reference models or as cells during design composition. A Sheet model, by comparison, is
used to create a finished drawing. Sheet models are used to reference Design models during
drawing composition and can accept 3D references to 2D Sheet models.

When a new design file is created, a default model Design Model is created. This model
cannot be deleted, however the properties can be edited.

Eagle Point still requires the use of 3D models in order to place and retrieve elements
at an elevation other than zero.

For the majority of commands, Eagle Point interacts with the current or active model
within a design file. This means when placing or selecting elements, Eagle Point only
“sees” the active model. For example, when placing nodes in a design file only, placing
Node ID 1 in Model 1 and Node ID 1 in model 2 won’t produce duplicate nodes. When
selecting nodes, only Node 1 in the active model is selected. Commands that don’t
behave this way deal with drawing alignments, profiles and sewers.

An alignment is written to the active model the first time it is created, and the model
name is stored with the alignment. As a result, any time the alignment is redrawn it is
redrawn in the same model.

RoadCalc Profiles are written to the active model the first time a profile is created.
Storm and Sanitary Sewer Networks are also written to the active model the first time
the network is created. The model name is stored with the network, so any time the
network is redrawn, it is redrawn in the same model. Alignments, profiles and sewers
behave differently so that plan and profile sheets attach the correct models for the
reference files.

When clicking on the View Alignment icon in Manage Alignments, the system displays
the correct drawing file as well as the correct model. Other commands (e.g. View Plan
in Sewers, View Alignment Graphics in RoadCalc) only display the correct drawing file
and do not switch to the model that contains the alignment. This is so that you can get
back to the latest saved instance in the Plan drawing without having the model
switched.
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Working Units and Double Precision

Working units are the real-world units used when drawing or creating models in a DGN file.
Typically, the working units are defined in seed DGN files, from which working DGN files are
created. Normally, they do not require any adjustment.

Master units and subunits can be chosen by name, such as Feet and Inches, or Meters and
Centimeters. Changing the working units Unit Names does not affect the size of geometry in
the model.

Previous versions of MicroStation performed all calculations in IEEE double precision floating
point, however, many design coordinates were stored as 32-bit integers. This put a lot of
importance on properly setting working units and global origin. In contrast, MicroStation V8
stores design coordinates in double precision floating point.

The concept of establishing the DGN file coordinate system by defining master/sub/positional
units is retained because it makes the MicroStation V8 conversion process easier and it
retains equity in seed files, references, etc. However, in MicroStation V8, there is a great deal
of resolution between positional units. This makes DGN file setup considerably less important,
because the accuracy in terms of master units is nearly unaffected by unit setup. The use of
double precision coordinates also creates a design plane that is approximately 2 million times
larger on each axis, thus eliminating the need to adjust the Global Origin except in cases
where a V7 design file is needed.

In Eagle Point version 3.4.0 and earlier, a double precision file (.dbl) was maintained for every
design file used in conjunction with Eagle Point. This was done to insure that double precision
was maintained for all object coordinates placed by Eagle Point into MicroStation regardless
of working units and global origin.

MicroStation V8 no longer has the Enhanced Precision option since the element
coordinates are stored to double precision in the design file. Beginning with the Eagle
Point 4.1.0 release, the Eagle Point double precision (.dbl) file will no longer be created
or used in projects. As a result, MicroStation 95 is not supported in Eagle Point version
4.1.0. If you try to use a project created in 4.1.0 with an earlier version of Eagle Point
node synchronization errors are likely.

In MicroStation SE and J, an Enhanced Precision option is available to store all of the
double precision information on the elements themselves within the design file. When
using Eagle Point 4.1.0 or greater with SE or J, the Enhanced Precision setting
(MS_ENHANCEDPRECISION) must be enabled. Refer to the MicroStation
documentation for additional information.

Levels

Levels now have customizable attributes (color, width, style, etc.) that are used to build a
standardized level and symbology structure across design files. The number of levels
associated with a design file is also unlimited. Levels can be frozen, locked, deleted, and/or
not plotted. You can organize levels into different filters and only manage the desired group at
a time. In either Level Display or Level Manager, right-click on the column header to choose
which columns to display.

A new option exists to “freeze” a level when working with AutoCAD DWG support. When a
level is frozen, any cells or references placed on that level will not be displayed, regardless of
how the levels are used with the elements that make up the cell or reference. Turning On/Off a
level still controls the visibility of the objects in the same fashion as previous MicroStation
releases.

The levels in a design file may be ‘inherited’ by attaching either a separate design file for the
purpose of using the same levels or attaching a level library (*.DGNLIB) file. In either case, the
association is dynamic so when levels are updated in either the attached design file or the
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level library, they are refreshed and updated. Levels can also be imported directly into the
design file from either type of file. Refer to the MicroStation documentation for more
information on using Level Libraries.

Eagle Point’s user interface when working in MicroStation V8 allows level names to be
used for any CAD settings. If the level does not exist in the design file, Eagle Point will
create the level with the specified settings when the elements are drawn. If Level
Libraries are in use, Eagle Point utilizes the capabilities contained therein.

Additionally, when placing CAD objects via Eagle Point they can now be set to
“ByLevel,” rather than specifying a specific color, style or width. When an element that
uses ByLevel symbology settings is placed on a level, it uses the symbology settings
assigned to that level. To control the symbology settings for each level, use the Level
Manager dialog box. This allows you to change the level symbology in the Level
Manager and have all “ByLevel” elements update to the new setting or mimic AutoCAD
layering standards you may already be using.

The Manipulate Level Groups and Manage Level Groups commands have been
modified to allow similar functionality to that of the Level Manager in MicroStation. You
can now use global freeze/thaw and lock/unlock functions along with the display
(on/off) option. You must click on Apply for the changes to take effect.

Cells and Cell Libraries

Cell names can now range in size from six to over 500 characters. When attaching a
MicroStation V7 cell library during a MicroStation V8 session, it will automatically be converted
to MicroStation V8 format. The original version is saved in the directory specified by the
MS_BACKUP configuration variable.

MicroStation V8 cell libraries can contain both 2D and 3D cells. 2D cells can be placed in 3D
DGN files and vice versa. When a 3D cell is placed in a 2D DGN file, the cell's Top view is
displayed. A V8 design file can also be attached as a cell library. Doing so will treat each
individual model as a cell. Essentially, cell libraries are nothing more than a V8 DGN with
multiple models, with the model name acting as the cell name.

Note: It is not possible to save a MicroStation V8 cell library as a MicroStation V7 cell library.

Throughout the software, the user interface has been modified to use cells that are
greater than 6 characters in length (256 character maximum). This includes the Node
Field Code Library and various other commands that allow the placement of cells.

Eagle Point allows the use of V7 cell libraries as a starting point when working in
MicroStation V8. Eagle Point ensures that the MicroStation V8 cell libraries the software
uses are kept separate from the MicroStation V7 files that already exist. Please refer to
Converting Seed Files and Cell Libraries on page 13 for more information.

Design History

Design History is an optional feature in MicroStation V8. When enabled, Design History stores
historical information inside the DGN file. When initializing a DGN file's Design History, the file
records a snapshot of the design. As revisions are added, the file grows to contain all the
changes made to each element in the design file. The Design History feature in MicroStation
V8 allows you to view the design file, query element information, and undo or redo changes to
the graphic elements in the design file.

The design history will not, however, store earlier versions of the data stored in the
Eagle Point data files. Because of this limitation, it is recommended that Design History
be disabled when Eagle Point is running with MicroStation V8. By default, the Eagle
Point user configuration file (EGPT.UCF) disables the ability to create the design
history for a design file and disables the ability to save or commit a revision to a design
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file that may have had the design history started outside of the Eagle Point
environment.

If you decide that you want to use the MicroStation capability to use the Design History,
Eagle Point elements will lose their association if restored through the design history.

Here is a partial list of objects that will be adversely affected if they are deleted or
overwritten by selecting history changes.

Alignments

Annotation

Intersection Design elements

Irrigation structures

Lots

Nodes

Plants (for annotation/plant table/plant mixes)
Profiles

Profile structures (manholes/inlets)

Sewer structures

Surface Model objects

Utilities

To disable the Design History feature add the following lines to the .ucf file that is used
when running Eagle Point.

MS DESIGN HISTORY = CREATE=0
MS DESIGN HISTORY > COMMIT=0

The CREATE variable does not allow the creation of a new design history if one hasn’t
already been started in the design file. The COMMIT variable does not allow you to save
to design history.

AccuSnap

AccuSnap is a new snapping mode that may be used by itself, or in combination with
AccuDraw, to reduce the number of mouse clicks required within a design session. AccuSnap
provides a graphical pointer that is used when snapping to objects within the CAD graphic. In
AccuSnap mode, with Show Tentative Hint turned on, simply select a tool and move the
pointer over the elements. AccuSnap then displays the nearest snap point with a crosshair
(the tentative hint). When moving the pointer close to this “hint”, the crosshair changes to a
heavier line weight “X” and the element highlights, denoting a tentative snap point. This
eliminates the need to press the Tentative button. The location of the snapping point depends
on the Snap Mode setting. Following is a description of the available settings:

Enable AccuSnap — This can be accessed from the Snap Mode Button Bar. Type the
letter ‘U’ to suspend AccuSnap or type ‘J’ to toggle it ON/OFF once it has been started
via AccuDraw or a similar command. The Enable AccuSnap toggle displays a yellow “x”
indicating the point to which you are going to snap. Toggling the feature off will suppress
Tentative Hints, Display Icons and other toggles from being used.

Show Tentative Hint — Shows a crosshair on an object that may be selected with the
current snap mode.

Identify Elements Automatically — This option automatically accepts an object when it is
selected.(e.g. when deleting objects, performing an Element Info, etc.)

Pop-up info (Automatic/Tentative) — This option displays a tool tip while hovering over an
element (Automatic) or after a tentative snap.
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Use when placing a Fence - If the configuration variable MS_ ACCUSNAPFENCE is
created, then AccuSnap can be used to place a fence. The setting is enabled/disabled
simply by the existence of the variable (no value is specified).

Eagle Point supports the AccuSnap feature that identifies elements using a highlight
when performing a selection. This allows snapping to objects without having to select a
tentative snap. When Identify Elements Automatically is toggled ON in the General tab
of the AccuSnap Settings dialog box, you only have to position the pointer over an
element for MicroStation to identify and highlight it without a mouse click. When this
feature is toggled OFF, at least two data points, or a tentative point followed by two
data points, are required to select or delete the same object.

The AccuSnap feature is available in all commands that allow a select object or multiple
select objects. Some examples of where this would occur include the annotation
commands in Drafting, the select pipe and annotate pipe commands in Profiles, the
selection commands in Landscape Design, and the Convert Objects to Reach
command in Storm and Sanitary Sewers.

References

The number of reference files that can be attached is now unlimited. You may also attach a
DWG file as a reference without needing to switch workmodes. Other enhancements to
reference attachments in MicroStation V8 allow you to attach 3D files to 2D files and vice
versa.

If reference files/models are attached to a model that an alignment or sewer network is
associated with, those references are attached to the Plan and Profile sheets using the
‘Copy Attachment’ setting. In order for the nested references to be seen in the sheet,
the default nest depth set in your Preferences needs to be set to ‘1’ or greater before
creating the sheets.

Text and Text Styles

MicroStation has a robust text editor that doubles as a word processor. For example, bolding,
italicizing and underlining can all be applied on the fly, and a single line of text can contain up
to 64,000 characters. You can right-click within the editor and use the find command to search
the selected text. There is even a spell-checker with a customizable dictionary file. This editor
is enabled when the Workspace - Preferences > Text > Text Editor Style is set to “Word
Processor”.

Text Styles are now used in lieu of just using a font definition. Text styles contain the font
definition as well as other properties such as underline, overline, background, spacing and
justification. Changes in Text styles are applied to existing text elements as well.

TrueType and AutoCAD shx font files are both supported natively for use within text styles.

Within Eagle Point, the text CAD settings dialog boxes also have a Text style option
that can be used in place of specifying a font only. This allows you to take advantage of
the additional properties that are contained within the style as opposed to using the
active text properties when only specifying the font.

Other Miscellaneous V8 Features

The Design file cleanup utility (Utilities = Data Cleanup) allows you to clean up elements that
have gaps or overlaps or where duplication of elements occurs. This is particularly useful for
cleaning up aerial photos or scanned contours. Depending upon the quality of the image
scanned and the actual scan, there may be many vector elements (contours) that should be
cleaned up so that the surface model generated from these elements will have fewer
unnecessary triangles.
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Other miscellaneous features/changes include:

¢ Unlimited Design File size (the maximum physical size of the DGN file is limited only
by the operating system).

e 256-character limit on cells (while using Eagle Point).

No size limit on the number of elements in a cell, thereby allowing for more detailed

geometry to be contained within it.

A line string, shape or point curve can have up to 5000 vertices.

There is no limit on the number of components in a complex chain or complex shape.

There is no limit on the number of graphic groups in a DGN file.

An unlimited amount of undos may be performed within a session.

View groups: A view group is a set of view window layouts applicable to a model

within an open DGN file.

Customizable mouse wheel support.

e Message Center: This dialog box contains a running log of system messages and
any further description about the message if applicable.

e Toolbars are now customizable with a right mouse button click.

e Distance tool now displays distances in text that can be copied by highlighting the
value, right mouse button clicking and selecting Copy.

Known Limitations

Items that are not supported:

1. Projects worked on in 4.1.0 (and later) cannot be used in 3.4.0 (and earlier) when
sharing support files due to file format changes to the Node Field Code Library,
Attribute Styles and Linework Libraries. Therefore all machines must be
upgraded to the latest version of Eagle Point at the same time. This affects all
CAD plug-ins so companies with MicroStation and AutoCAD/Eagle Point
Graphics Engine must have all machines running the 4.1.0 (or later) version.

2. MicroStation 95 is no longer supported through Eagle Point. This is due to the
fact that the system no longer reads or writes to the external double precision file.

3. MicroStation V8 builds prior to 08.01.00.07 are not supported.

4. Eagle Point commands will only work in the V8 workmode when using
MicroStation V8.

Actions that are not recommended:

1. Do not use two different versions of MicroStation on the same Eagle Point project
(e.g. MicroStation J and V8).

2. Do not perform a Save As V7 after every session. Only perform a Save As V7
when you are ready to deliver a V7 design file. Refer to Saving a V8 Design File
to V7 on page 12 of this document.

3. Do not use design models in MicroStation V8 if you intend to deliver V7 design
files and the associated Eagle Point project data by performing a Save As. Refer
to Saving a V8 Design File to V7 on page 12 of this document.

4. Do not use version 4.1.0 support files in version 3.4.0 (or earlier). This applies to
all Eagle Point projects running in AutoCAD, MicroStation and/or the Eagle Point
Graphics Engine.

Before You Upgrade to Eagle Point 4.1.0

Create a backup copy of your Support, Images and project directories if you decide that
you are going to keep an earlier version of MicroStation in production with Eagle Point
projects. Eagle Point will automatically check the version of the selected seed files and cell
libraries as they are attached to determine if conversion is necessary. If conversion is
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necessary, a separate V8 sub-folder is created and the seed file and cell library files are
placed there, leaving the original files in their original location. For example, the V8 version of
the Eagle Point default seed files would be converted and placed in the
...\EGPT\Support\DGN\V8 folder and the V7 files would remain in the .. \EGPT\Support\DGN
folder.

If you decide to only use the V8 version of MicroStation office-wide, it is suggested that you
backup your Support, Images and project directories. You may also want to convert any
custom seed files to the V8 format either by opening them individually or using the Batch
Converter command within MicroStation V8. This is not required, however, as Eagle Point will
place the converted seed files and cell libraries in a V8 sub-folder in the folder where the file(s)
currently reside.

Update all machines with Eagle Point to the latest version at the same time. This is due
to support file formats being changed to allow for long cell names and level names. Installing
the 4.1.0 (version) of Eagle Point will change the file format of these library files such that
earlier versions of Eagle Point (98 through 2003) will no longer work if you are sharing support
files on the network. Therefore, you must upgrade all machines in your office to the latest
version of Eagle Point at the same time if you share support files on the network.

All users must have the necessary rights to create, write and modify files and folders
within the Support directory. Support files that require conversion will be converted and
backed up automatically into a subfolder under the Support directory when projects are
opened and accessed. To make sure the files are converted and backed up successfully,
users must have the necessary rights.

Installing Eagle Point for MicroStation V8

The following sections outline what steps are needed in order to properly configure Eagle
Point 4.1.0 to run with MicroStation V8. Choose the type of installation (Node License or
Network License) and whether or not a previous version of Eagle Point already exists from the
four main headings below.

Node Existing

If you are using a single seat node license and you are installing over or updating a version of
Eagle Point:

Install directly from CD or install 4.1.0 from the patch accessed at
http://www.eaglepoint.com/support/patches/. Refer to Installing a Quarterly CD or Installing
a Maintenance Patch in the Getting Started manual found on the 4.1.0 CD for more
information.

Use the Administrator program to configure the CAD engine by selecting the location of the
MicroStation V8 ustation.exe. Refer to Configure CAD Engine in the Getting Started manual
for more information.

Note: If you installed MicroStation V8 over another version of MicroStation (installing using the
same folder structure), you will need to first uninstall Eagle Point and then select MicroStation
V8 during the re-installation. This needs to be done so Eagle Point recognizes that the CAD
Engine has changed from the one that was previously installed within the same folder.

Node New

If you are intending to use a single seat node license and you are installing Eagle Point for the
first time (or after it has been uninstalled), you may select MicroStation V8 as a CAD engine.
Insert the CD and perform the installation as follows:
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Install 4.1.0 from the CD and select MicroStationV8 as the CAD engine. Refer to Starting the
Installation Process for the First Time in the Getting Started manual found on the 4.1.0 CD
for more information.

Network Existing

Refer to Chapter 4, Network License Installation in the Getting Started manual for
additional information on network installations.

Administrator

If you are the administrator for Eagle Point in your office, you first need to build a client
deployment from the 4.1.0 CD that can be installed to the client machines. Eagle Point
will determine if you have already installed a deployment or if a deployment already
exists in the specified folder. When you are asked to use the existing configuration of the
client deployment, select the No button. This is done so you can select MicroStation V8
as one of the CAD programs to install. All previous settings will however, be used as the
default values for the creation of the new configuration file.

While building the deployment, there is an option for prompting clients for CAD
configuration (Prompt Clients for CAD Configuration). If this option is turned off, choose
MicroStation V8 as one of the CAD engines when prompted.

Client Deployment Existing

If you are using a multi-seat network license and you are installing over or updating a
version of Eagle Point, run the setup.exe from the client deployment folder on the
network. You will not be prompted to choose a CAD engine. Therefore, you will need to
reconfigure the CAD engine to MicroStation V8 after you have completed running the
setup.

Use the Administrator program to configure the CAD engine to MicroStation V8. Refer to
Configure CAD Engine in the Getting Started manual for more information.

Client Deployment New

If you are using a multi-seat network license and you are running the client deployment of
Eagle Point for the first time (or after it has been uninstalled), prompting to select
MicroStation V8 as a CAD engine may or may not occur based on whether or not the
client deployment prompts clients for CAD configuration.

Run the setup.exe from the client deployment folder on the network. If you are prompted
to select your CAD, choose MicroStationV8.

Network New

Refer to Chapter 4, Network License Installation in the Getting Started manual for
additional information on network installations.

Administrator

If you are the administrator for Eagle Point in your office, you first need to build a
deployment from the 4.1.0 CD that can be installed to the client machines.

Client Deployment Existing

If you are using a multi-seat network license and you are installing over or updating a
version of Eagle Point, run the setup.exe from the client deployment folder on the
network. You will not be prompted to choose a CAD engine. Therefore, you will need to
reconfigure the CAD engine to MicroStation V8 after you have completed running the
setup.
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Use the Administrator program to configure the CAD engine to MicroStation V8. Refer to
Configure CAD Engine in the Getting Started manual for more information.

Client Deployment New

If you are using a multi-seat network license and you are running the client deployment of
Eagle Point for the first time (or after it has been uninstalled), you may or may not be
prompted to select MicroStation V8 as a CAD engine based on whether your client
deployment prompts clients for CAD configuration.

Run the setup.exe from the client deployment folder on the network. If you are prompted
to select your CAD, choose MicroStationV8.

Converting Eagle Point Projects

When opening an existing project that has been worked on in a previous version of Eagle
Point (3.4.0 or earlier), the system will prompt you to convert the project when working in
MicroStation V8.

Initially, the Default CAD settings and the selected project design file are converted on open.
Other V7 design files, attached cell libraries and Eagle Point project files are converted as the
files are accessed on an as needed basis.

Converting Data Files

The file format used to store utilities displayed in the Manage Utilities dialog box has been
updated to a new format. The old format read the PROJECTNAME.UTL data file for
information related to utilities in the Manage Ultilities dialog box. Any changes made to the
utilities from this point forward will be stored in two new files:

PROJECTNAME.UTG and PROJECTNAME.UTS

The default CAD settings accessed from the EGPT menu are converted to a different project
file for MicroStation V8 projects (e.g. PROJECTNAME.CSM). This project file allows for
storing level names and text styles that were not available in earlier versions of MicroStation.

When this project file is created during conversion, Eagle Point checks two possible
configuration settings in MicroStation that control level mapping or changes to the level prefix.
By default, Eagle Point is not configured to apply a CSV file or prefix the levels to the project
data files when converting a project.

Note: In MicroStation J, you have the capability to name levels. These level names will be
used when converting the design file and will appear in the design file as the level name as
expected. However, the Eagle Point CAD settings will NOT be changed to reflect the named
levels as created in MicroStation J.

The V7 design files for existing projects will be converted. For each of these design files, you
may be prompted to either upgrade to V8 or open as read-only, thereby keeping itin a V7
format. However, upgrading to the V8 format for each design file opened is required in order to
continue working within Eagle Point. If not, the Eagle Point plug-in will not load and none of
the Eagle Point commands will be usable. MicroStation also copies the original V7 design file
to the MicroStation temp directory (as specified by the MS_BACKUP or MS_TEMP variables).

Level Mapping when Converting V7 Design Files

When a design file is converted to V8, the levels may change based on the current
configuration. A traditional V7 formatted design file only has levels 1-63. If you are using
named levels in V7, all existing level names remain unchanged.
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Without setting the configuration variable, the default MicroStation setting is to prefix ‘Level’ to
each of the level numbers (e.g. 1 becomes “Level 1”). Therefore, opening and converting
project drawings outside of the Eagle Point workspace is not recommended. Doing so may
lead to levels being mapped to something other than what they had been initially. This can be
avoided by setting the MS_V7_LEVEL_NAME_PREFIX to a blank space.

When opening a V7 format design file within Eagle Point, the word ‘level’ is not applied as a
prefix based on the following configuration variable within the EGPT.UCF file.

MS V7 LEVEL NAME PREFIX =

# Using this variable as specified (blank space) will prevent any
# prefix from appending to a level name on conversion to the V8
format.

If you are in the process or have adopted a level standard that takes advantage of level
names, you can map a design file’s existing levels (1-63) to level names at the time the file is
converted to the V8 format. This happens automatically using the MS_V7TOV8_CSVNAME
variable. Here is an example of how it might appear in your configuration file:

MS V7TOV8 CSVNAME = C:\egpt\supportl\levelmap.csv

# Specifies the name of the level mapping file. This file may be used
# to conform MicroStation V7 design files to new standard symbology

# upon conversion to the V8 format.

Levels also have additional symbology that can be specifically assigned to the level. For
example, you can assign level 10 to be named UTILITIES and have a specific color, style and
weight.

When elements are placed through Eagle Point, a new CAD setting has been added to place
objects ByLevel, which allows them to be placed using the level properties for color, style etc.
To take advantage of these ByLevel settings in Eagle Point, you will need to manually set
each of these settings to ByLevel through the CAD Settings dialog boxes.

The .CSV (comma-separated value) file can only be used when the file format is converted to
the V8 format. Once the design file has been converted, you can still attach level libraries and
share or import those levels, however this will not affect Eagle Point CAD settings for the
project. See MicroStation Help regarding level libraries for more information.

Typical Section Level Mapping Considerations

MicroStation V8 allows users to use a .CSV file to map levels when converting a V7 drawing
to the V8 format. This may be desirable when converting a plan drawing to a new standard of
levels, however, the same CSV file may not be appropriate for converting other types of
design files within a project.

To make sure typical section design files are converted properly, Eagle Point temporarily
suppresses any .CSV file assigned in the current workspace. Original settings are restored
upon completion of loading the typical section. This occurs because the current level names
(1,2,3, etc.) are still necessary for commands to function properly.

If you are using a custom level-mapping .CSV file for design file conversions, this mapping file
will continue to be used when opening all other design files.

Saving a V8 Design File to V7

If you intend to deliver a MicroStation V7 DGN formatted file, simply perform a Save As to the
MicroStation V7 DGN file format. If you intend on delivering/creating a project that can be
opened within Eagle Point using MicroStation SE/J, it is strongly recommended to not use
additional models within the project. You also need to maintain applicable V7 cell library(s)
files to accompany the project, as V8 cell libraries are not backwards compatible.
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Note: While performing a Save As V7, you are unable to overwrite the current V8 design file. If
you intend to use the V7 design file and its corresponding data in Eagle Point, the design file
must be renamed to the original V8 name.

If the design file contains multiple models, each of the models will be saved as a separate
design file.

Converting Eagle Point Support Files

If Project and Sub-project prototype files require some CAD settings to be updated they will be
updated on an as-needed basis as commands are used within Eagle Point. Therefore,
converting prototype files is not required. However, the files can be updated manually if
desired.

The Node Field Code library files, the Attribute Styles library file and any Data Collection
Linework Library files have been converted to support longer block, cell and level names in
Eagle Point 4.1.0 or greater. This means these files cannot be used in Eagle Point 3.4.0 or
earlier.

If using Eagle Point with MicroStation V8 and a previous version of MicroStation, it is possible
to share the same Support and Images folders. Eagle Point will create a V8 sub-folder to keep
the seed files and cell libraries separate. Refer to Converting Seed Files and Cell Libraries on
page 13 for additional information.

Eagle Point Project and Sub-project Prototype Files

An Eagle Point prototype specifies the drawing that is used as a template/seed file, as well as
all Default CAD Settings, Units, Formats, Precision, Plot Scales, etc.

In order to change prototype files to encompass newer CAD standards that have been
developed, you first need to develop a project that contains the appropriate settings to use as
a basis. If a prototype already exists that bears the name of the prototype being replaced (e.g.
Smith Engineering - Standards), then you must delete that prototype from the list and replace
it with a new prototype the same name.

Sub-project prototypes need to be treated in the same fashion if changes need to be made to
the current prototype files. This includes any RoadCalc, Water Surface Profiling, and Storm
and Sanitary Sewer sub-project prototype files.

Plot formats and Surface Modeling prototypes are treated independently of the project and
subproject prototype files. These files, such as those found in the Sewers modules and
RoadCalc, do not need to be deleted and replaced. Instead, load the format that needs to be
changed using the Load Format command in the Format Library of the respective command.
Then, make your changes and click on the Save To button in the format library to save the
changes. Surface Model prototypes may be changed in the same fashion by first loading the
desired format, making the changes and saving them back to the desired format.

Converting Seed Files and Cell Libraries

Eagle Point allows the use of V7 cell libraries and seed files as a basis when working in
MicroStation V8. These include cell libraries used for the Node Field Code Library, Eagle Point
symbols or any custom cell libraries that may be attached via an Eagle Point command. Eagle
Point ensures that the MicroStation V8 cell libraries and seed files that the software uses are
kept separate from the MicroStation V7 files that may already exist. When a MicroStation V7
cell library is selected in MicroStation V8, Eagle Point does the following:

1. If the cell library is V7, Eagle Point creates a V8 sub-folder in the cell library’s current
folder (e.g. ...\EGPT\Images).
2. The V7 cell library is copied into the sub-folder (e.g. ... \EGPT\Images\V8).
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3. Eagle Point converts the newly copied V7 cell library in the sub-folder to a V8 cell
library.
4. The converted V8 cell library in the sub-folder is attached to the design file as needed.

When a MicroStation V7 seed file is selected in MicroStation V8, Eagle Point does the
following:

1. If the seed file is a V7 design file, Eagle Point creates a V8 sub-folder in the seed file’s
current folder (e.g. ... \EGPT\Support\DGN).

2. The V7 design file is copied to the sub-folder (e.g. ... \EGPT\Support\DGN\V8).

3. Eagle Point converts the newly copied V7 design file in the sub-folder to a V8 design
file.

4. Eagle Point copies the V8 design file as needed.

If a cell library is already a V8 cell library, no action is taken. Eagle Point attaches the cell
library from the current location. Likewise, if the seed file is already in the V8 format, Eagle
Point just uses the seed files and copies the design file to the project location.

If you are running with Eagle Point in MicroStation V7 and attempt to attach a V8 cell library or
use a V8 seed file, Eagle Point displays an error message stating that it cannot attach the cell
library or seed file due to it being an invalid version.

Note: V8 cell libraries cannot be saved back to V7.

Eagle Point always does a version check prior to attaching any cell library file or before it uses
any seed file to determine if the file should first be copied and converted to a V8 sub-folder or
not. This procedure is done so users working in the MicroStation V7 format do not need to
alter project/prototype paths to continue working.

Node Field Code Library Files

The Node (Field Code) Library file format (*.SYM files) has changed to allow long block names
for AutoCAD and Eagle Point Graphics Engine users as well as long cell names (now up to
256 characters). Additionally, support for named levels has been added for MicroStation V8
users. Because of these changes, these library files will not work with earlier versions of Eagle
Point (3.4.0 or earlier).

When a previous versioned project (3.4.0 or earlier) is opened in Eagle Point 4.1.0 (or later),
the Node Field Code Library specified for the project is converted. During conversion, a copy
of the original file will be placed in the ... \EGPT\Support\Backup directory.

Once any project has been opened in 4.1.0 (or later) and the Node Field Code library has
been converted, you will not be able to open this or any project using that Node Field Code
Library from within an earlier Eagle Point version (3.4.0 or earlier). If some machines in you
office environment are not updated to Eagle Point 4.1.0 or later, they must point to a separate
Support folder if you are sharing support files on a network.

Attribute Styles Library File

The Attribute Styles Library file (EPATTRIB.LIB) located in the .. \EGPT\Support folder has
been changed to account for named levels used in MicroStation V8. Because of this change,
this file will not work with earlier versions of Eagle Point (3.4.0 or earlier).

The Attribute Styles Library in the current Support directory is converted upon opening the first
project in Eagle Point 4.1.0 (or later) from a machine that is using a Support directory used
with a previous version of Eagle Point (3.4.0 or earlier). During conversion, a copy of the
original file will be placed in the .. \EGPT\Support\Backup directory.

Once any project has been opened in 4.1.0 (or later) and the Attribute Styles Library has been
converted, you will not be able to open this or any project from within an older Eagle Point
version (3.4.0 or earlier). If some machines in your office environment are not updated to
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Eagle Point 4.1.0 or later, they must point to a separate Support folder if you are sharing
support files on a network.

Data Collection Line Work Library Files

The Data Collection Line Work Library file format (*.LWL) has changed to account for level
names in MicroStation V8. Because of these changes, 4.1.0 line work library files will not work
with earlier versions of Eagle Point (3.4.0 or earlier).

The current Line Work library file will be converted to the new format upon accessing a Data
Collection command within Eagle Point 4.1.0 (or later) from a machine that is using a Support
directory with a previous version of Eagle Point (3.4.0 or earlier). During conversion, a copy of
the original file is placed in the .. \EGPT\Support\DC\Backup folder.

Additional Topics

Here are some additional topics that may be helpful when integrating Eagle Point with
MicroStation V8.

Configuration Files

By default, the configuration variables specific to Eagle Point are saved to the EGPT.UCF file.
The file is specified using the Configure CAD command in the Eagle Point Administrator by
the command line argument. For example, to specify the EGPT.UCF, the command line
argument should be as follows:

-wuegpt

If you prefer, you may specify a different user configuration file as long as the content of the
file includes the lines required by Eagle Point to operate. A separate Project Configuration File
(*.PCF) can also be specified. This is done by specifying the file name in the Eagle Point
project prototype settings file.

This can also be specified by creating a project prototype in Eagle Point and manually editing
the PROTO###.SET file. To specify a project configuration file, enter the following variable
followed by the name of the configuration file:

MSPROJECTWORKSPACES egpt

The variable needs to be inserted in the correct location in the file, as the file is sorted
alphabetically. An example of how this may appear in the settings file is as follows:

FormatsNodesPntProtI 1
FormatsStal 100
MSPROJECTWORKSPACES egpt
PrecAngDecI 4
PrecAngDMSI 2
PrecCategoryI O

The contents of the default Eagle Point user configuration file are:

# THESE LINES REQUIRED BY EAGLE POINT

_USTN_USERDESCR = Eagle Point Workspace
# This variable sets the workspace to the Eagle Point Workspace

_USTN_PROJECTNAME = EaglePoint
# This variable defines the MicroStation project as being Eagle Point.

MS INITAPPS = epm8sysm.ma
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This statement loads the Eagle Point software, or ‘plugin’ within
MicroStation. Without this being loaded, Eagle Point commands will
not function.

HH 3 H

# ______________________________________________________________________
# THESE LINES ARE RECOMMENDED BY EAGLE POINT AND CAN BE CHANGED

# FOR COMPANY CUSTOMIZATION

# MS VITOV8 CSVNAME = C:\egpt\support\levelmap.csv

# Specifies the name of the level mapping file. This file may be used

# to conform MicroStation V7 design files to new standard symbology

# upon conversion to the V8 format.

MS V7 LEVEL NAME PREFIX =
# Using this variable as specified (blank space) will prevent any
# prefix from appending to a level name on conversion to the V8 format.

MS DESIGN HISTORY = Create=0
MS DESIGN HISTORY > Commit=0

The MS DESIGN HISTORY = Create=0 and MS DESIGN HISTORY > Commit=0
variables disables the ability to create or save a design history.
If you delete these variables, Design History will be enabled. The
Eagle Point data files will NOT be updated when using Design History
resulting in possible loss of data. Therefore it is not recommended
that you use Design History when working with Eagle Point projects.

H o FH

Using the Batch Converter on a Project Folder

Use the Batch Convert utility located under the Utilities menu in MicroStation V8 to convert all
design files for a project to the MicroStation V8 format rather than having to do them one at a
time..

Note: Prior to performing any batch conversion, it is suggested that a backup of the files or
directories is created. It is also important that any conversions to a MicroStation V8 design file
are performed through Eagle Point so the Eagle Point workspace settings are in effect. Not
doing so may create undesired level names.

Batch conversion is particularly useful when converting many cross-section or plan and profile
plot sheets at the same time. To do this, follow these steps:

1. Choose the default output format. This should be set to V8.

2. Choose the default destination. Click on the “Browse for Destination” button and
select the same folder in which the files are currently located.

3. Select Edit > Add Files. Select the project data directory and highlight all of the
design files in that location.

4. Click on the Add button to add the files to the Selected Files list box.

5. Check the Include Subdirectories option ON if additional files located in a

subfolder need to be converted. For example, if the base drawing folder is

selected all of the plot files located in a subfolder (e.g., \Plot) would be converted

at the same time.

Click on the Done button to add the selected files to the list of conversion tasks.

Click on the Process Batch Convert Job icon. The Files to Convert dialog box

displays.

8. Click on the Convert button near the bottom to begin the conversion process.
Each successive design file in the list is automatically highlighted and converted.

9. Press Done when the last file has been converted.

No

For more information on the Batch Conversion Utility, refer to the MicroStation Online help
(Keywords Batch Conversion).

Tip: The MicroStation variable MS_OPENV7 can be set so that users are not prompted to
convert design files. This may be set in lieu of using the Batch Conversion tool, however, it
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would be wise to have MicroStation prompt users so they know what design files are being
converted.
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